
SECTION A—OBJECTIVE TYPE QUESTIONS 

1. Answer any 4 out of the given 6 questions on Employability Skills. (4 × 1 = 4 marks)
(a) While working on a class poster activity, your group needs to share ideas clearly. Which three essential

elements of communication help in exchanging information smoothly?
(i) Sender, Message, Receiver

(ii) Reading, Writing, Editing
(iii) Listening, Practising, Presenting
(iv) Copying, Sharing, Uploading

(b) Rekha is selected to lead her Science Project team. She has never led a team before but trusts her ability
to manage tasks. She guides her team, divides work properly and completes the project on time. Which
option shows Rekha’s self-confidence?

(i) Constantly saying she is not good enough
(ii) Avoiding responsibility and letting others lead

(iii) Trusting her abilities and guiding her team effectively
(iv) Refusing to listen to her team members

(c) Which device is used to store data permanently?
(i) RAM (ii) ROM

(iii) Hard Disk (iv) Cache
(d) An online store sells both digital products (eBooks) and physical items (bags, accessories). What type of

business is this?
(i) Product-based business (ii) Hybrid business

(iii) Service-based business (iv) Retail business
(e) Which of the following items belongs to biotic category?

(i) Plastic bottle (ii) Banana peel
(iii) Metal can (iv) Glass jar
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	 (f)	 Which of the following is the primary goal of Green Skills? 
	 (i)	 Increasing consumption of non-renewable resources 
	 (ii)	 Promoting environmentally sustainable practices in various careers 
	 (iii)	 Encouraging the use of disposable materials 
	 (iv)	 Maximizing production regardless of pollution

	 2.	 Answer any 5 out of the given 6 questions.	 (5 × 1 = 5 marks)
	 (a)	 Which segment of the IT-BPM industry focuses on resolving customer queries through calls or chat? 
	 (i)	 IT Services	 (ii)	 Business Process Management (BPM) 
	 (iii)	 Software Product Companies	 (iv)	 Engineering Research and Development
	 (b)	 Kamini works for a company that processes insurance claims for a US firm using online tools. Her company 

does not serve the public directly but supports the foreign client’s internal processes. Which of the 
following best describes her company? 

	 (i)	 Domestic Service Provider	 (ii)	 Global In-house Center (GIC) 
	 (iii)	 Indian Service Provider (ISP)	 (iv)	 Software Product Company
	 (c)	 Tisha goes to a bookstore to buy stationery. At the billing counter, she pays using a card that the cashier 

swipes through a machine. The card works only when it is swiped and contains her account number 
stored on a black magnetic strip at the back. Which type of card is Tisha using?

	 (i)	 Smart card	 (ii)	 Magnetic strip card 
	 (iii)	 Contactless RFID card	 (iv)	 Virtual card
	 (d)	 Geetika practises Rapid Typing Tutor for 20 minutes daily. She learns to type words without looking at the 

keyboard. One day, she tries to use the keyboard to move the mouse pointer. Which operation is not 
performed by a keyboard?

	 (i)	 Typing letters and numbers 
	 (ii)	 Moving the cursor in a text editor using arrow keys 
	 (iii)	 Clicking items on the screen 
	 (iv)	 Using keyboard shortcuts for copy-paste
	 (e)	 While using Rapid Typing Tutor, Sunil notices that the typing speed and accuracy are displayed in real time 

as he types. Which feature of the interface is being used?
	 (i)	 Lesson menu	 (ii)	 Typing statistics panel 
	 (iii)	 Settings panel	 (iv)	 Exit button
	 (f)	 Shobha practises typing daily on Rapid Typing Tutor. She realizes her fingers automatically move to the 

correct keys and she does not make many errors. Which factor contributes most to this improvement?
	 (i)	 Regular practice and muscle memory	 (ii)	 Listening to key sounds 
	 (iii)	 Using the mouse to type	 (iv)	 Reading notes while typing

	 3.	 Answer any 5 out of the given 6 questions.	 (5 × 1 = 5 marks)
	 (a)	 Namit types his assignment in LibreOffice Writer and saves it. He notices that the default extension is not 

the same as Microsoft Word. Which of the following is the default LibreOffice Writer file extension?
	 (i)	 .doc	 (ii)	 .odt 
	 (iii)	 .txt	 (iv)	 .pdf
	 (b)	 To change the view of the document or adjust zoom, you can use the __________.
	 (i)	 Menu Bar	 (ii)	 Toolbar 
	 (iii)	 Status Bar	 (iv)	 Title Bar
	 (c)	 While formatting her assignment, Surbhi wants to select text from the middle of one sentence to the 

middle of another sentence using only the keyboard. Which method should she use?
	 (i)	 Click once, then hold Shift and click again where she wants to stop. 
	 (ii)	 Hold Ctrl and press A 
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	 (iii)	 Press Shift + Arrow keys from the starting point to the ending point 
	 (iv)	 Double-click both sentences
	 (d)	 Shalini wants to insert a picture of the solar system into her report. She also wants to resize it to fit the 

page. Which menu options in LibreOffice Writer should she use?
	 (i)	 Insert → Image	 (ii)	 Format → Paragraph → Alignment 
	 (iii)	 Tools → Spelling	 (iv)	 Table → Insert Table
	 (e)	 Suraj is working on a financial statement in LibreOffice Writer. He wants to quickly apply a predefined 

design to his table. When he selects the table and chooses the relevant option, a dialog box appears 
showing different table styles. Which dialog box appears for this purpose?

	 (i)	 Insert Table	 (ii)	 Sort Table 
	 (iii)	 AutoFormat	 (iv)	 Split Table
	 (f)	 Anil is working on a document in LibreOffice Writer that will be published online. He wants to see how the 

document will look when viewed in a web browser, without page breaks and margins. Which document 
view should Anil select?

	 (i)	 Print View	 (ii)	 Web View
	 (iii)	 Normal View	 (iv)	 Full Screen View

	 4.	 Answer any 5 out of the given 6 questions.	 (5 × 1 = 5 marks)
	 (a)	 Vidhi is working on a product inventory sheet. She wants to highlight all items marked as ‘Out of Stock’ 

by changing their text color and cell background without altering the actual data. Which feature should 
she apply?

	 (i)	 Sorting	 (ii)	 Searching
	 (iii)	 Filtering	 (iv)	 Formatting
	 (b)	 Akshita has entered the monthly electricity expenses in a single column of a LibreOffice Calc sheet. She 

wants to instantly calculate the total without typing any formula. Which method should she use?
	 (i)	 Copy and paste the values into another cell 
	 (ii)	 Sum() 
	 (iii)	 Sorting the column 
	 (iv)	 Filtering the data
	 (c)	 Arpit has written a formula in a cell that refers to other cells in a LibreOffice Calc worksheet. He cuts and 

pastes this formula cell to another location. How will the referenced cell addresses behave?
	 (i)	 Both row and column references will change according to the new position. 
	 (ii)	 Only row references will change. 
	 (iii)	 Only column references will change. 
	 (iv)	 The cell references will remain unchanged.
	 (d)	 Kritika enters 6 in cell A1 and 3 in cell B1. She applies the formula =A1*B1+2^3 in cell C1. What will the 

result be?
	 (i)	 26	 (ii)	 30
	 (iii)	 22	 (iv)	 18
	 (e)	 Jatin has applied validation rules in a LibreOffice Calc sheet to restrict user input. Now he wants to remove 

all formulas and restrictions from the selected cells without affecting other formatting. Which option 
should he use? 

	 (i)	 Delete Formatting	 (ii)	 Delete All
	 (iii)	 Delete Formula	 (iv)	 Clear Comments
	 (f)	 Sahil is designing a profit calculator in LibreOffice Calc. He wants Calc to evaluate his entry as a formula 

instead of plain text. Which symbol must he type first?
	 (i)	 = sign	 (ii)	 Alphabet
	 (iii)	 Number	 (iv)	 Space
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	 5.	 Answer any 5 out of the given 6 questions.	 (5 × 1 = 5 marks)
	 (a)	 Kamakshi is learning to create presentations using LibreOffice Impress. She notices various panes used to 

design and manage slides. Which of the following is not a standard component of the Impress window?
	 (i)	 Workspace	 (ii)	 Slides pane
	 (iii)	 Status bar	 (iv)	 Drawing pane
	 (b)	 Rachit has applied a ‘Push’ transition to a slide. He now wants every slide in the presentation to have the 

same effect without setting it individually. Which action should he take?
	 (i)	 Apply to Selected Slides	 (ii)	 Apply to All Slides
	 (iii)	 Modify Transition	 (iv)	 On Mouse Click
	 (c)	 Pragati is preparing a self-running presentation for a class project. She wants to set exact duration for 

each slide. Which Impress feature allows her to achieve this?
	 (i)	 Rehearse Timings	 (ii)	 Custom Animation
	 (iii)	 Task Pane	 (iv)	 Slide Sorter
	 (d)	 Samridhi is preparing a presentation for her school project. She wants all slides to have the same 

background, fonts and style, so that any change in content automatically follows the same design. Which 
feature should she use?

	 (i)	 Master Slide	 (ii)	 Custom Animations
	 (iii)	 Slide Transitions	 (iv)	 Handout View
	 (e)	 Rajesh wants to exit the slideshow immediately in LibreOffice Impress. Which key should he use?
	 (i)	 Esc	 (ii)	 F5
	 (iii)	 Shift+F5	 (iv)	 Ctrl+S
	 (f)	 Manoj wants to present only selected slides from his presentation to a specific audience, while keeping 

the rest of the slides unchanged for another group. Which feature will help him do this?
	 (i)	 Custom Slide Show	 (ii)	 Slide Show View
	 (iii)	 Rehearsal	 (iv)	 Notes Pane

SECTION B—SUBJECTIVE TYPE QUESTIONS
Answer any 3 out of the given 5 questions on Employability Skills in 20–30 words each.� (3 × 2 = 6 marks)
	 6.	 Effective communication requires both the sender and the receiver to understand the message clearly. Why is 

understanding the message important in communication?

	 7.	 Rajat feels nervous before exams and finds it difficult to concentrate while studying. Identify the problem Rajat 
is facing. Suggest one self-management technique he can use to overcome it.

	 8.	 What is self-awareness? How many types of self-awareness do we have?

	 9.	 Yuvan observed that local shopkeepers were losing customers because they did not provide digital payment 
options. He learned about digital tools and helped them set up online payment systems. Explain how  
Yuvan’s actions show the activities and steps required to make a business fully functional and competitive in 
the digital age.

	 10.	 Who is an entrepreneur? What is the relationship between entrepreneur, entrepreneurship and enterprise?

Answer any 4 out of the given 6 questions in 20–30 words each.	 (4 × 2 = 8 marks)
	 11.	 Suppose a doctor wants to examine detailed images of internal organs and soft tissues of a patient to diagnose 

problems related to the brain, spine or muscles. He requires a medical imaging technique that uses strong 
magnetic fields and radio waves, and does not use harmful radiation. Which IT-based medical imaging 
application should the doctor use?

	 12.	 Aarushi, a student, wants to learn new topics at her own pace using interactive modules, quizzes and online 
tutorials. Her school provides access to digital learning platforms that allow her to study from home or 
anywhere with internet access. Explain how IT can be used in education to support Aarushi’s learning and 
name the types of e-learning platforms she can use.
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	 13.	 Suppose you are preparing a set of personalized letters in LibreOffice Writer. You want the word ‘Pending’ to 
appear in bold automatically in all letters without formatting each one manually. Which feature should you 
use to perform this task efficiently and how would you access it?

	 14.	 A student is preparing a marks analysis sheet in LibreOffice Calc showing subject-wise performance of the class. 
The teacher suggests using a visual representation to quickly compare marks across subjects.

	 (a)	 Identify the tool for the above task and where it is present in LibreOffice Calc. 
	 (b)	 Explain any two advantages of using this tool.

	 15.	 Nikhil is preparing a presentation in LibreOffice Impress for a school seminar. He wants his slides to be easy to 
read and visually attractive. Mention any four guidelines Nikhil should follow while designing his presentation.

	 16.	 Ajeet is practising typing without looking at the keyboard. His instructor tells him to use all the fingers properly 
and bring them to a fixed position after pressing other keys.

	 (a)	 Name the typing position being discussed. 
	 (b)	 Explain why this position is important for rapid touch typing.

Answer any 3 out of the given 5 questions in 50–80 words each.	 (3 × 4 = 12 marks)

	 17.	 Samrat is the class teacher of Grade 9 and needs to send individual progress reports to parents. Students’ 
names, roll numbers and marks are stored in a spreadsheet. He wants each report to automatically display the 
correct student details. Which process should Samrat use in LibreOffice Writer to generate these individual 
reports? Write the steps involved.

	 18.	 The following table shows the stock available for different stationery products in a warehouse. Use appropriate 
spreadsheet functions to answer the questions below. 

Stationery Code Opening Stock Received Sold Closing Stock

Product P01 500 200 350
Notebook P02 400 150 300
Marker P03 300 100 180
Eraser P04 250 120 200

	 (a)	 Enter the formula in F3 to calculate the closing stock of Pen. 
	 (b)	 Enter the formula in C8 to find the maximum opening stock. 
	 (c)	 Enter the formula in E8 to find the minimum quantity sold. 
	 (d)	 Enter the formula in A8 to count the number of products.

	 19.	 Garima is working on a marks analysis sheet in LibreOffice Calc. She wants to quickly find the highest marks, 
lowest marks and average marks from a large set of values without calculating them manually. Her teacher 
suggests using built-in functions instead of performing calculations step by step. Why is it better to use 
built-in functions instead of manual calculations in a spreadsheet? List and explain any three commonly used 
spreadsheet functions in LibreOffice Calc.

	 20.	 Manvik is preparing a presentation for a school assembly using LibreOffice Impress. He wants all slides to 
have the same background, font style and logo. He also wants any change made once to apply to all slides 
automatically. Explain how the Master Slide feature in LibreOffice Impress helps Rohan maintain consistency 
in his presentation.

	 21.	 Sanjana has just started practising rapid touch typing. Her teacher insists that she should always return her 
fingers to a fixed set of keys after typing each word. Why is the home row position important in touch typing? 
Mention any three benefits of using the home row keys correctly.


